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Mace AgriFlo Series 3 Product Manual

Product Support
Should you experience difficulty in using this product, please contact your 
supplier.
We also welcome feedback from customers who feel that their experience 
may provide an improvement to the product or may be beneficial to other 
users. Please go to www.macemeters.com 

Disclaimer
No warranties of any nature are extended by this document.
Measuring and Control Equipment Co. Pty. Ltd. (MACE) will not accept any 
financial or other responsibility that may be the result of your use of this 
information, including direct, indirect, special or consequential damages.
You must be careful to ensure that the use of this information complies with 
the laws, rules and regulations of the jurisdictions with respect to which it 
is used. MACE assumes no responsibility for personal or property damage 
caused by the misuse of this equipment.

Copyright
Information in this document is subject to change without notice. The 
software described in this document is furnished under a license agreement 
or nondisclosure agreement. The software may be used or copied only in 
accordance with the terms of those agreements. No part of this publication 
may be reproduced, stored in a retrieval system, or transmitted in any form or 
any means electronic or mechanical, including photocopying and recording 
for any purpose other than the purchaser’s personal use without the written 
permission of Measuring & Control Equipment P/L.
Copyright © 1996-2009. MACE P/L.  All rights reserved.

This is an interactive PDF
This user manual is setup as an interactive PDF. The user can click on 
any of the “Chapters” in the Table of contents to navigate directly to the 
corresponding page. To return to the Table of contents click on the “Return to 
TOC” button at the bottom of each page.
References to chapters in the body text are hyperlinks. 

Part No. 825-302	 Rev. 2.0	 Code. 090209

About Doppler ultrasonics

MACE Flo-series instruments utilise the Doppler Effect to measure velocity of 
stream flows.  
The Doppler Effect (after C. J. Doppler 1803-53) is defined as, “the apparent 
change in the frequency of sound or electromagnetic radiation due to 
relative motion between the source and the observer” (Uvarov & Isaacs 
(1986).  Dictionary of Science).
The MACE Flo-Series instruments transmit an ultrasonic (sound) wave into 
the flow.  This sound wave is reflected by acoustically reflective particles 
(e.g. air bubbles, suspended solids) and the instrument detects the reflected 
frequencies. The difference between the transmitted frequency and the 
received frequencies is directly proportional to the velocity of the  
stream flow.  

In full or partially full pipes, the velocity of the stream flow varies markedly 
across the cross-section of the pipe.  Typically, velocity is zero along the wall 
of the pipe and increases to a maximum at or about the centre of the pipe.  
MACE Flo-series instruments receive reflected frequencies from particles 
moving at these different velocities.  The greater the area of flow moving at  
a particular velocity, the greater the number of reflections with the 
respective frequency shift.  The average velocity of the stream is therefore 
calculated by averaging those frequency reflections received across the 
whole stream profile.

http://macemeters.com/
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Section A: 

Hardware Manual
Mace AgriFlo Series 3

1.0 	Introduction to AgriFlo Series 3

This manual describes the installation, use and maintenance of the AgriFlo Series 3.
The AgriFlo Series 3 typically consists of four main components:
•	 The electronics module.
•	 The sensor(s). 
•	 The solar panel (or power supply).
•	 Flocom+ software enabling you to configure  

and download your AgriFlo Series 3.
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2.0 	Warnings

2.1 Intrinsic Safety
The AgriFlo Series 3 is NOT an intrinsically safe instrument and should not be 
installed in hazardous (explosive) environments. Should an intrinsically safe 
instrument be required, MACE can offer other instruments with this approval 
level.

2.2 Floods
MACE recommends that the AgriFlo Series 3 electronics module be mounted 
above known flood peak levels. MACE will not be liable for damage caused by 
flooding. (The unit is weatherproof, but NOT waterproof and should NOT be 
submerged).

2.3 Sunlight
MACE recommends that the AgriFlo Series 3 electronics module be mounted 
so that the LCD faces in a direction away from direct sunlight (ie South in the 
Southern Hemisphere and North in the Northern Hemisphere).

2.4 Cable damage
MACE recommends that all cables be appropriately routed through electrical 
conduit or other similar mechanism.  MACE will not be liable for damage to 
cables, especially if it is caused by vehicles, digging implements, animals or 
debris in the pipe or channel. 

2.5 Insects and moisture
After the AgriFlo Series 3 system has been installed and fully tested, MACE 
recommends the use of expanding “space filler” foam down the first 5 to 10cm 
(2 to 4 “) of the conduit or mounting pole to prevent insect/moisture ingress.

2.6 Battery life
Care must be taken when a mains power supply is used to charge the internal 
battery instead of a solar panel. If the mains power remains disconnected 
for an extended period of time, the internal battery may be permanently 
damaged.

2.7 Electromagnetic compatibility (EMC)
This is a Class A product. In a domestic environment this product may cause 
radio interference in which case the user may be required to take adequate 
measures.

3.0 	Site selection

When selecting a suitable site to measure flow and mount the instrument, 
you must consider the following:

1. Does the stream flow that I wish to measure contain sufficient 
acoustically reflective particles such as sand, silt, dirt, leaves or air 
bubbles? (The stream that you wish to measure must contain at least 100 
parts per million of acoustically reflective particles that are greater than 
75 microns in size).
Yes – The stream flow is suitable for Doppler ultrasonic flow measurement.
No – The stream flow is unsuitable for Doppler ultrasonic flow measurement.

2. Does the pipe in which I am measuring, run full or partially full?
Full – A velocity only sensor can be used.
Partial – A combined depth/velocity sensor will be required.

3. If the pipe flows full, is the internal pressure of the pipe within the range 
0 - 25 m (0 - 253kPa, 0 – 37 psi)?
Yes – The stream flow is suitable for Doppler ultrasonic flow measurement.
No – The stream flow is suitable for Doppler ultrasonic flow measurement. 
only if it contains at least 100 parts per million of suspended solids that are 
greater than 75 microns in size.

4. Can I get access to the outside wall of the pipe for mounting the sensor?
Yes – Consider using an insert velocity sensor if the pipe runs full.
No – Must use a strap mount sensor internally.
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3.0 Site selection - continued

5. Does the proposed site have obstructions in the pipe which might cause 
irregularities in the flow (eg. elbows, constrictions, valves, gates etc)?
Yes – You will need to install the sensor at a point where there is at least 8 
pipe diameters of straight pipe with no obstructions. MACE recommends 
that the sensor is mounted so that there is a distance of at least six pipe 
diameters of straight pipe in front of it and at least two pipe diameters of 
straight pipe behind it.
No – Even when there are no obvious obstructions, MACE recommends 
observing the instructions described above.
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3.0 Site selection - continued

6. Where is the best place to mount the sensor in a Full pipe?
The sensor should be mounted on the side wall of the pipe, between the  
2 and 5 o’ clock positions. A ball valve should be used when mounting 
“Insert” type sensor to allow for easy maintenance.

SENSOR MOUNTING POSITION - FULL PIPE

WARNING - Don’t mount the sensor at the top of the pipe as air pockets 
could give unreliable readings. Don’t mount the sensor at the bottom 
of the pipe as silt build-up can cover the sensor. Only mount the sensor 
between 2 and 5 o’clock as shown above.

7. Where is the best place to mount the sensor in a partially full pipe  
or channel? 
The sensor must be mounted such that the depth sensor is always covered 
by water to a depth of at least 50mm (2 inches). Refer diagram over page.

8. Is there likely to be silt build-up over the sensor?
If this is the case, MACE recommends mounting the sensor on the side wall of 
the pipe instead of near the bottom of the pipe. Refer diagram over page.

9. Is there enough sunlight for the solar panel to work efficiently?
Yes – Mount solar panel as per instructions  
(see 8.1 Solar panel installation on a 2” pole)
No – A mains powered trickle charger should be used to charge the internal 
battery.

DEPTH SENSOR MOUNTING POSITION - PARTIALLY FULL PIPE

DEPTH SENSOR MOUNTING POSITION - OPEN CHANNEL

50mm (2 inches)

NOTE: Sensor should be mounted on the side of the channel when sediment 
or weed is present

Water level

Water level

50mm (2 inches)

x

0.6x

Water level

Water level

NOTE: Straight run requirements for open channels are the same as for closed
pipes. The “diameter” to use when calculating your straight run should be the 
maximum depth.

10. How far can the sensor be mounted from the electronics module? 
A maximum of 50 metres (150ft) of cable is available on any MACE sensor. 

11. How do I customise the AgriFlo Series 3 for my application?
Use the application software, FloCom+ to:
•	 Configure the unit for your site. For example, this includes setting the pipe 

diameter and logging interval.
•	 View the velocity profile measured by the sensors. This is useful if you think 

there may be irregularities in the flow at the site or you want to check the 
operation of the unit.

•	 Download data from the AgriFlo Series 3.
FloCom+ is available for download at www.macemeters.com

Users are advised to ascertain the suitability of solar panels for 
their application by checking relevant solar radiation maps for 
their region (for example those found at  
http://rredc.nrel.gov/solar/old_data/nsrdb/redbook/atlas/  ). 
As a guideline, for an AgriFlo with 3 Doppler sensors and 
measuring every 5 minutes, at least 3 hours sunlight per day.

http://macemeters.com/
http://rredc.nrel.gov/solar/old_data/nsrdb/redbook/atlas/
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4.0 	Sensor types

The AgriFlo Series 3 sensors measure the amount of water flowing in the pipe 
using one of two methods. When the pipe is full, only the velocity of the flow 
is measured as the cross sectional area of the flow is constant. In partially full 
pipes or open channels, the velocity and depth of the flow are measured in 
order to calculate flow rate. A combination of up to three MACE velocity and/or 
MACE velocity/depth sensors may be installed and configured.

4.1 	Insertion sensors
This type of sensor is used in full pipes where access into the pipe is impractical 
or when it may be necessary to remove the sensor in the future without 
stopping the flow or emptying the pipe.
Insertion sensors require access to the outside wall of the pipe in which the 
sensor is to be mounted. The 2” insertion sensor should be used in pipes that 
have a diameter of greater than 100 mm (4”).

NOTE: MACE recommends that a ball or gate valve is always used when 
installing insertion sensors so that sensor maintenance can occur without 
requiring the pipe to be emptied of liquid.

4.2 	Strap mount sensors
“Strap mount” type. This type of configuration is used in full pipes when 
access to the pipe is available and the pipe can be emptied when installation or 
maintenance is required.
“Strap mount velocity/depth” type. This type of sensor must be used in pipes 
that run partially full or in open channels.  
There are several different types of straps used to hold the “strap mount” 
sensors in pipes:
•	 Plastic expandable mounting straps (polypropylene)
•	 Mounting plate (polypropylene) 
A plastic expandable mounting “strap” can be used to secure the sensor in 
place. These straps are made from polypropylene and come in five lengths to 
suit different pipe diameters.
•	 225-300mm (12” max)	 	 •  300-450mm (18” max)
•	 450-625mm (25” max)	 	 •  600-725mm (29” max)
•	 700-810mm (32” max)
Single mounting plates are normally used in large pipes where a cost-effective 
solution is required. The sensor is attached to the plate, which is then bolted to 
the inside surface of the pipe. This plate is supplied in polypropylene.

3. You are now ready to insert the sensor but first you must determine how 
far into the pipe the sensor face needs to be inserted. The sensor face must 
be the only thing that intrudes into the flow. Accurate measurements must 
be taken to get the values x, y and z as shown in the diagram over the page.
4. Measure value z. Measure from the top of the sensor head to the top of the 
sensor shaft. Write the number as your z value.

5.0 	Installing an insertion sensor

1. Attach a male 2” BSP or NPT nipple to the pipe in a manner suitable for the 
pipe material. This fitting must:
•	 Be at right angles to the flow
•	 Provide for a clean join inside the pipe (no burring etc)
•	 Be watertight

WARNING - DO NOT mount this fitting: 
•  In the centre, at the top of the pipe (may contain trapped air) 
•  In the centre, on the  bottom of the pipe  
	(may contain a sediment load)

2. Fit a full bore 2” gate or ball valve to the male nipple, using thread sealant 
to ensure that it makes a water tight seal.

1 1

2 2



10  	 Section A   Hardware Manual Return to TOC      Mace Agriflo Series3   Product Manual              11Return to TOC

5.0 Installing an insertion sensor - continued

HOW TO CALCULATE INSERTION MEASURMENT FOR TRANSDUCER

x

y
x+y=z

z

4 55. Measure value x. Take a 
measurement from the top of 
the ball valve to the inside of 
the pipe wall. NOTE: You need 
the end of the tape measure 
to be level with the inside 
diameter of the pipe wall. 
6. Calculate value y. Value y is 
the difference between value x 
and value z. 

7. Apply thread sealant onto the thread of the sensor to ensure that it makes 
a water tight joint with the valve. Screw the sensor assembly into the valve. 
8. Make sure that the 3/4” gland nut is only finger tight. This will allow the 
sensor head to be moved freely while the head is aligned into the flow.
9. Open the valve fully and push the sensor head into the flow so it fully 
enters the stream without exposing any shaft. To get the sensor in exactly 
the right position you need to make the distance between the top of the ball 
valve to the top of the sensor shaft the same as value y. Refer to the photos 
over page.

12. When the installation is complete, the sensor shaft should be pointing 
directly towards the centre of the pipe in all planes.
13. Carefully route the cable from the sensor back to where the electronics box 
will be mounted. 

Particular care should be taken when routing cables to ensure 
that moisture CANNOT enter the connector of the sensor cable as 
permanent damage may occur

MACE recommends that all cables be appropriately routed through 
electrical conduit or other similar mechanism.  MACE will not be 
liable for damage to cables, especially that caused by vehicles, 
digging implements, animals or debris in the pipe or channel

11

10. Now that the insertion depth is correct, rotate the sensor so that the grub 
screw at the top of the sensor shaft is accurately pointing in the direction of 
the longest straight section of pipe. Remember you must have a distance of 
at least six pipe diameters of straight pipe in front of the sensor and two pipe 
diameters of distance behind the sensor.  
NOTE: The grub screw indicates the velocity sensing face.
11. Tighten the 3/4” gland nut to lock the sensor in place. 

Do not use thread sealant on the 3/4” gland nut

109

7 8
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6.0 	Installing a sensor on a plastic strap

These plastic (polypropylene) straps are typically used to mount the 
sensor in locations where temporary monitoring will take place or when 
it is undesirable to drill in to the pipe wall.  They allow for both very quick 
installation and removal of a strap mount sensor.
1. Hold the sensor so that you can see the ‘eyes’ of the sensor in front of you, 
the sensor cable running to your left
2. Place the mounting strap on the ground or a bench so that you can see the 
chamfered edge of the strap in front of you. Place the ‘toe’ of the sensor into 
the front of the hole in the strap. Press the body of the sensor down onto  
the strap.
3. Turn the whole assembly over.  Make sure the cut out in the strap sits 
down around the ‘foot’ on the sensor.
4. You should see six countersunk holes in the strap.  Fit the six screws 
supplied (M3 x 8 mm Phillips head countersunk 304 s/s).

Use only a hand screwdriver.  Do not over tighten these screws as 
permanent damage to the thread may result

5. Tie the cable to the plastic strap using the holes and cable ties provided. 
Make sure that the knob of the cable tie sits to the back of the assembly, out 
of the flow. DO NOT OVERTIGHTEN CABLE TIES.
6. Place the strap so you are behind the sensor looking upstream.

Upstream is preferred (due to better debris shedding characteristics 
of the bevelled leading edge) but not critical as this can be reversed in 
FloCom+ software. Ensure that minimum straight pipe requirements are 
still met.

432

7. A stainless steel buckle is provided. Slide the buckle onto the mounting 
strap as shown.  
8. The left side of the strap will simply run through the buckle.  The position 
of the buckle on the left side of the strap determines the diameter of the 
hoop.  Therefore, the largest diameter occurs when you first place the buckle 
on the strap.  The right side of the strap curves around inside the left and 
tucks into the buckle.  Pick up the left side of the mounting strap and curve it 
over to form a semi circle.  
9. Bring the right side of the strap up, inside the left and tuck into the 
mounting strap.  The strap should now form a complete hoop.
10. Position the buckle so that the whole assembly is slightly too large to 
comfortably fit in the pipe
11. Now, form a ‘Z’ at the creases in the strap as shown below.

5 7

9 11
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13 13

14 15

12. Hold the ‘Z’ with one hand, the sensor with the other and place the 
assembly into the pipe reaching as far as is comfortable. Ensure that the 
sensor is parallel to the flow and in the bottom part of the pipe, off set to 
either side (if there is a build up of debris the sensor will not get covered)
13. Press out the ‘Z’ in the hoop with the palm of your hand. The strap will 
‘snap’ into place.  You won’t be able to move the mounting strap up or down 
the pipe by hand if done properly.

14. Carefully route the cable from the sensor back to where the electronics 
box will be mounted as described in installation of insertion sensors.

Particular care should be taken when routing cables to ensure that 
moisture CANNOT enter the connector or the air reference line of the 
sensor cable as permanent damage may occur

15. To remove, open the strap by wedging a screwdriver into the flattened ‘Z’ 
and bearing down on the strap.

7.0 	Installing a sensor using the  
mounting plate

The mounting plate consists of a plastic plate with four 6mm clearance holes.
1. Attach the sensor head securely to the mounting plate by the six 3mm 
screws supplied (M3 x 8 mm Phillips head countersunk 304 s/s).

Use only a hand screwdriver.  Do not over tighten these screws as 
permanent damage to the thread may result

1 4

2. Tie the cable to the mounting plate using the holes and cable ties 
provided. Make sure that the knob of the cable tie sits to the back of the 
assembly, out of the flow. DO NOT OVERTIGHTEN CABLE TIES.
3. The cable from the sensor to the instrument should then be run inside 
the pipe and secured to the pipe in such a manner as to prevent damage by 
debris in the pipe.  For example, in most cases the cable should be routed 
through electrical conduit.
4. Using a fixing method that is suitable for the pipe material, the sensor 
plate should be attached to the pipe or channel in a position such that the 
sensor is always facing parallel with the pipe. 

WARNING: Take care to ensure no gap exists between the plate 
and the pipe wall. This will stop the collection of debris.

5. Carefully route the cable from the sensor back to where the electronics 
box will be mounted as described in installation of insertion sensors.

Particular care should be taken when routing cables to ensure 
moisture CANNOT enter the connector or the air reference line of 
the sensor cable as permanent damage may occur

6.0 Installing a sensor on a plastic strap - continued
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8.0 	Installing AgriFlo power options

8.1 	Solar panel installation on a 2” pole
The solar panel is used to charge the internal battery of the AgriFlo Series 3 
where mains power is unavailable.

Users are advised to ascertain the suitability of solar panels for their 
application by checking relevant solar radiation maps for their region 
(for example those found at http://rredc.nrel.gov/solar/old_data/nsrdb/
redbook/atlas/ ). As a guideline, for an AgriFlo with 3 Doppler sensors 
and measuring every 5 minutes, at least 3 hours sunlight is required  
per day

1. Place an M8 bolt with M8 flat washer through the hole in left arm of the 
mounting bracket. Ensure that the head of the bolt is on the INSIDE and the 
thread faces outward.
2. On the OUTSIDE of the bracket, place an M8 spring washer then an M8 nut. 
DO NOT TIGHTEN THE NUT.
3. Repeat these two steps on the right hand side of the bracket.
4. Holding the solar panel carefully, hold it above the two arms of the 
mounting bracket.
5. Slide the solar panel down so that the head of each of the M8 bolts fits in 
the channel on either side of the solar panel.

Ensure that the gutter of the solar panel is positioned between the flat 
washer and the head of the M8 Bolt

7. Place the u-bolt provided in the solar panel mounting kit around the pole.

5 5

8. Place the solar panel mounting bracket onto the u-bolt. Ensure that the 
arms of the bracket face out from the pole and that the mounting hole on 
each arm is towards the top of each arm.
9. Slide the bracket to the desired position on the pole, taking care to place it 
at the desired height and so that the open face of the bracket faces towards 
the sun.
10. Place the 3/8” flat and spring washers on to the U-bolt and tighten the two 
nuts so that the bracket is secured on the pole.
11. Tilt the solar panel so that the active side faces towards the sun (North in 
Southern hemisphere, South in Northern hemisphere) at an angle specified 
in the data sheet provided. (your latitude + 15°).

11 12

12. Now tighten the M8 nuts on each side of the mounting bracket to secure.
13. The cables from the solar panel/charger to the electronics unit must be 
enclosed to minimise exposure to the elements. The cable should be either 
routed through conduit or through the solar panel mounting pole. You will 
need a hole drilled in the mounting pole at the top near the solar panel as 
well as a cut away where the electronics unit is to be mounted. Refer to the 
pictures below.

13 13

http://rredc.nrel.gov/solar/old_data/nsrdb/redbook/atlas/
http://rredc.nrel.gov/solar/old_data/nsrdb/redbook/atlas/
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14. Ensure that the cable from the solar panel is terminated using the three-pin 
connector provided in the electronics box and that the polarity is correct.  The 
photo below shows the location of the three-pin connector inside the AgriFlo.
15. The polarity is labelled on the circuit board near the connector.

NOTE: When wiring the solar panel either of the ground (-ve) terminals 
may be used

14

1

1

15

1

1

8.2 	Installing a MACE mains powered trickle charger
In certain applications or where the use of a solar panel is impractical or 
undesirable, the AgriFlo can be powered from any DC source of 16-30 Volts 
(2Amps). 

When the ambient temperature is less than -10°C (14F), the battery 
should be removed to avoid permanent damage to the battery. The 
AgriFlo should be powered by an external power source

1. The charger available from MACE (Part No. 850-323) comes complete with 
a circular barrel connector that plugs directly into the electronics module.  
See photos over page.

8.1 	Solar panel installation on a 2” pole - continued

2. Alternatively, if a DC source other than a MACE charger is used, this 
is terminated using the same three-pin connector as for the solar panel 
described above.

8.3 	Powering the AgriFlo with an external battery
In certain applications, it may be desireable to power the AgriFlo with an 
external battery. 
1. The Series 3 AgriFlo can be powered by an external 12V battery through 
the dedicated “External Battery 12V” terminal. See photos below.

2. If a solar panel is connected to the AgriFlo as in Chapter 8.1, the internal 
charging circuit of the AgriFlo will also charge the external battery. The 
charging circuitry of the AgriFlo has a 20 Watt capacity.

If the external battery is charged via its own solar panel and NOT 
through the AgriFlo charging circuit, the internal AgriFlo battery 
will discharge competely

NOTE:  The electronics module 
should be installed before 
connecting the solar panel. Refer to 
Chapters 10 & 11 for more detail

MACE highly reccomends the use 
of Tri-spikes on the top of the solar 
panel to reduce accumulation of 
bird droppings on the front face of 
the solar panel

The barrel connector for the 16-30VDC charger input is centre 
positive
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9.0 	Electronics module

The electronics module is the central processing unit of the AgriFlo Series 3. 
It includes the enclosure, battery and circuit boards that control the device.
On the front of the AgriFlo Series 3, a backlit liquid crystal display (LCD) 
allows the user to see an on-site readout of channel information and status 
messages. Pressing either membrane switch will turn on the LCD. 
The flashing flow indicator is a high intensity LED that emits a flash every 
second when flow is sensed in any of the configured channels.

Do not look directly at the flashing rate indicator as permanent eye 
damage may occur

The membrane switches can be used to scroll the display between the 
various parameters being measured.
A serial communications port is located on the bottom face of the main 
enclosure. Using the MACE serial data cable (Part No. 891-300) between this 
port and a PC, users can configure, troubleshoot and download the device.

LCD Display

Secure Latch
with Padlock

Hole

Membrane Switch
(scrolls the display up & down)

ELECTRONICS MODULE - FRONT

Flashing Flow Indicator

NOTE: Door not shown
Conduit Cable Entry Point

Pole Cable Entry Point

12v Battery

Bracket

Charger Input 
16-30VDC
(Centre of jack 
is positive)

Doppler Sensor Input

External Battery Input
12VDC
(Charged by Series3 Device)

Solar Panel/Charger 
Input 16-30VDC
(Use with Solar Panel
or Mains Plug Pack)

Serial Communications Port

ELECTRONICS MODULE - INSIDE

ELECTRONICS MODULE - UNDERSIDE

Controller Module (slot 0)

Module Slots 2-5

Doppler Module (slot 1)

Serial Communications Port
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10.0 	Installing the AgriFlo on a 2” pole

The sensor and power cables can be routed either directly through the inside 
of the 2” mounting pole or through electrical conduit.  Installation directions 
for both are provided below.

MACE recommends that the AgriFlo Series 3 electronics module be 
mounted so that the LCD faces in a direction away from direct sunlight.

10.1 	Sensor and power cables routed inside the pole
1. Place the electronics module on a work bench and using a hammer and 
screwdriver carefully knock out the plastic cable entry point from the rear 
of the enclosure. It is only thin plastic and is designed to break away at the 
edges so work your way around the edge of the oval shape until the cover is 
completely broken free of the unit.
2. File away any rough edges from the plastic cable entry point

1 2

3

4 5

6 7

3. Hold the electronics module up against the pole so that the oval cut-away 
on the pole matches the cable entry point. Route the sensor and power 
cables through the cable entry point as shown.

IMPORTANT: Apply NON-ACIDIC cure silicon sealant to the back of the 
electronics module in the channel around the cable entry point. This will 
stop water flowing down the pole and into the electronics module

4. Use the two “U” bolts, 3/8” nuts and 3/8” washers provided to secure the 
electronics module to the pole.

Do not overtighten the pole mounting bolts as permanent 
damage may occur to the electronics enclosure

5. Plug in both the sensor cable and solar panel cable into the sockets as 
shown in the picture below.

The Doppler sensor cable should be looped prior to connecting 
to act as a form of strain relief. Ensure that the sensor cable is 
securely attached by squeezing the slidelock and latching it  
in place

Ensure that the cable from the solar panel/charger is terminated 
using the three-pin connector provided in the electronics box and 
that the polarity is correct. The polarity is labelled on the circuit 
board near the connector

6. If using a 16-30VDC mains charger then plug this into the socket shown 
in the picture below. Alternatively, the charger may be wired into the solar 
panel screw terminal block (to the left of the socket).
7. Once all the cables are connected the system should be fully tested. 
Assuming everything is connected and fully functional the cable entry point 
should be filled with expanding “space filler” foam. This is to prevent insects 
and/or moisture damaging the system.
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10.2 	Sensor and power cables routed through conduit
1. Place the electronics module on a work bench. Using a power drill and 2” 
holesaw, carefully drill out the round plastic cable entry point at the base 
of the unit as shown below. It is only thin plastic and is designed to break 
away. Alternatively, the round cable entry point may be removed using the 
“hammer and screwdriver” method described in Chapter 10.1.
2. Use the two “U” bolts, 3/8” nuts and 3/8” washers provided to secure the 
electronics module to the pole.

Do not overtighten the pole mounting bolts as permanent damage may 
occur to the electronics enclosure

1 2

3 4

5 6

3. Carefully attach an electrical conduit adaptor (Clipsal 50mm or Carlon 1 1/2”) 
to the electronics module. 
4. Plug in both the sensor cable and solar panel cable into the sockets as 
shown in the picture below.

The Doppler sensor cable should be looped prior to connecting to act as 
a form of strain relief. Ensure that the sensor cable is securely attached, 
by squeezing the slidelock and latching it in place

Ensure that the cable from the solar panel/charger is terminated using 
the three-pin connector provided in the electronics box and that the 
polarity is correct. The polarity is labelled on the circuit board near the 
connector

5. if using a 16-30VDC mains charger then plug this into the socket shown 
in the picture below. Alternatively, the charger may be wired into the solar 
panel screw terminal block (to the left of the socket).
6. Once all your cables are plugged in you need to fully test the system. 
When you are happy that everything is connected and working properly you 
need to fill the cable entry point with expanding “space filler” foam. Fill down 
the first 5 to 10cm (2” to 4”) of the conduit. This is to prevent insects and/or 
moisture damaging the system.

11.0 	Installing the AgriFlo on a wall

21. Follow instructions on the previous 
page to drill out the cable entry point 
for routing cables through conduit.
2. Use four M8 screws, bolts or coach 
screws to secure the box to the wall. 
(Use flat washers between the screw 
head and the box).

Do not overtighten the wall 
mounting bolts as permanent 
damage may occur to the 
electronics enclosure

3. Follow instructions 3-6 on the 
previous page for routing the cables 
through conduit.
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12.0 	Installing additional cards

Users are advised to download data and stop the AgriFlo prior to 
installing additional cards.  See Chapter 24 and Chapter 27 for details

1. Open the Series3 enclosure and remove the three screws (using a #2 
Phillips screwdriver) fastening the PCB clamping bracket. Take care not to drop 
screws in the box as damage may occur to the circuitry. 

IMPORTANT: Before removing card from packaging you MUST earth 
yourself by touching one of the screws on the display module as shown 

1

3

3. Remove the MACE Series3 card from its packaging. Position the new card 
in your hand such that the large cream 48-pin connector is facing down and 
aligned with the mating connector on the backplane PCB.
4. Earth yourself again. Your finger must remain earthed on the screw 
whilst carefully inserting the card into any spare slot. Take care to align the 
pins of the two connectors together.  There is a slot at the top of the card 
area that helps the alignment process.  Ensure that the card is contained 
within this slot and press down firmly to ensure that it is seated fully.
5. Replace the PCB clamping bracket ensuring that the slots in the underside 
of the bracket are aligned with the tops of all the cards.  Fix the bracket into 
place with the 3 screws.  DO NOT over tighten the screws.
6. Connect to the instrument with a PC and configure the card using FloCom+ 
as detailed in the software section of this manual.

13.0 	Installing a Series3 FloSI card

The Flo Series Serial Interface (FloSI) is an optional upgrade module for  
Flo Series3 devices. The FloSI provides unconditional polling access to the 
most recent user configured measurement results of Flo Series3 devices.
The FloSI requires no routine maintenance and has no user serviceable 
components.
Configuration of the FloSI requires MACE Flocom+ software and successful 
PC communications with a MACE Flo Series3 device. The FloSI configuration 
settings are available from the settings menu of Flocom+ as detailed in the 
software section of this manual.

Installing the FloSi Card
Install the FloSI card as per the  procedure outlined in Chapter 12.0 Installing 
additional cards.

Wiring the FloSI
After installing the card, connect it to the remote device using either:
1.	The 9-pin d-connector (RS232, ASCII or RS232 ModBUS) for RS232;
2.	The 4-way terminal block for RS485 ModBUS mode;
3.	The 3-way terminal block for SDI-12 mode.
Pin out details for the various connectors are printed on the back of the FloSI 
card and below:

4

RS232
Pin 2 – Transmit Data (TxD)
Pin 3 – Receive Data (RxD)

Pin 5 – Ground (GND)
Pin 7 – Ready to Send (RTS)
Pin 8 – Clear to Send (CTS)

FloSI Card - Diagram
RS485

Pin 1 – Ground
Pin 2 - D1
Pin 3 - D0

Pin 4 - (+12V Out) 

SDI-12
Pin 1 – Ground

Pin 2 - Data
Pin 3 - (+12V Out) 

1234 123
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14.0 	Maintenance

Depending on the physical location and the type of flow being monitored, 
the AgriFlo Series 3 may require regular maintenance. Should the instrument 
require servicing, it must be returned to your vendor. 

14.1 	Battery maintenance
The AgriFlo Series 3 internal battery, if kept fully charged should last many 
years.  However, if the battery remains flat for an extended time, it may be 
damaged and should be replaced. Contact your vendor for a replacement 
battery.  

14.1.1 Removing the damaged/flat battery
1.	 Disconnect the battery cable assembly from the backplane board.
2.	 Carefully hold the battery in position.
3.	 Use a Phillips head screwdriver to remove the 3 screws which fasten the 

battery bracket to the main enclosure.
4.	 Carefully remove the battery from the main enclosure.
5.	 Disconnect the battery cable from the battery terminals.

14.1.2 Installing the new battery
1.	 Connect the battery cable to the new battery, with the red lead to the 

positive terminal of the battery and the black lead to the negative terminal.
2.	 Place the battery in the main enclosure and hold it in place.
3.	 Secure the new battery in place using the battery bracket and three screws.
4.	 Tighten all three screws.
5.	 Reconnect the battery cable assembly to the backplane board.

Damage to the AgriFlo Series 3 caused by incorrect battery replacement 
will void the warranty

Using a battery that is not approved MAY damage the AgriFlo Series 3 
and void the warranty

14.2 	Solar panel maintenance
The solar panel should be checked regularly for build up of solids such as dust 
and bird droppings.  These type of build-ups can affect the performance of 
the solar panel and result in a decrease of the charge that is received by the 
internal battery.  The solar panel should be cleaned with a wet brush or rag.

Do not use steel bristle brushes that may cause damage to the glass of 
the solar panel

14.3 	Sensor maintenance
To ensure trouble free data collection, sensors mounted in the flow should be 
kept free of built up debris, silt or grease. This is done by using a stiff bristle 
brush and carefully cleaning the sensor head and surrounding area. This 
process should be repeated as often as necessary in order to keep the sensors 
clean. Also check the sensor cable for physical damage.

Do not use steel bristle brushes that may cause damage to either 
the velocity or depth sensors

14.4 	Depth sensor reference filter maintenance
The ceramic depth sensor used by the AgriFlo Series 3 measures the 
hydrostatic pressure of the stream depth.  This sensor is vented to atmospheric 
pressure via a vent tube inside the sensor cable, which passes through a filter 
before entering the silica gel canister that is attached to the sensor connector 
and housed within the AgriFlo Series 3.  
In order to keep the depth sensor working properly, this vent tube must 
always remain free from moisture.  
The silica gel crystals contained within the reference filter effectively entrap 
atmospheric moisture.  However, these crystals require changing regularly to 
ensure that they are still effective.
The silica gel crystals used in the AgriFlo Series 3 are an indicator type.  When 
fresh they are a deep blue in colour and when exhausted they are light pink. 
The crystals should be replaced when they first appear to be light pink. The 
following procedure should be followed to change the crystals:
1.	 Remove the large rubber stopper on the bottom of the filter housing. (This 

is the stopper without the tube attached).
2.	 Empty the filter chamber of exhausted crystals.
3.	 Add new crystals (MACE Part No. 590-009) to the filter chamber so that 

there is enough room for the rubber stopper to be replaced.
4.	 Replace the rubber stopper.

Ensure that the reference filter tube is not crimped as a blockage 
will result in incorrect depth readings from the sensor

The longevity of the silica gel crystals is dependent on the amount 
of moisture in the atmosphere in which the instrument is mounted.  
It is recommended that the crystals be checked at least on a 
monthly basis

Do not eat the crystals. Wash hands after use
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Section B: 

Software Manual
FloCom+ for Mace AgriFlo Series 3

15.0 	Introduction to FloCom+ 

This manual describes FloCom+ and way it is used to configure, calibrate and 
extract data from MACE Flo Series3 devices.

System Requirements
Minimum system requirements for PC are:
• Windows® XP
• Serial port or USB to Serial Adapter 
• 4Mb available hard drive space
 
Windows is a registered trademark of Microsoft Corporation in the United States and other countries.

MACE Software End User License Agreement (EULA)
Users should read and accept the terms of the MACE EULA before installing 
FloCom+ on their PC.  The EULA can be found on the downloads page of the 
MACE website www.macemeters.com

http://macemeters.com/support/support-downloads.php?CategoryID=1
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16.0 	Installing the software

Download FloCom+ from our website www.macemeters.com
1. Run the “FlocomPlus_[version number].exe” file to start the installation 
process.
2. Follow the instructions on the welcome screen then click “Next” to move 
to the next screen.
3. Choose a location on your computer to install FloCom+. FloCom+ will setup 
a folder in your program files called “Mace\FlocomPlus”.  This is the default 
option. Click “Next” to continue.

4. Backing up replaced 
files. FloCom+ will ask 
if you wish to create  
backups of replaced 
files. We advise you to 
click “Yes” and then 
click “Next”.

5. Selecting a Program 
Manager Group. “Mace 
utilities” is the default 
group and we suggest 
leaving this as is. 

6. Starting installation. Click “Next” to begin installing FloCom+. 
7. FloCom+ will now install. Once the software installation is complete click 
“Finish” to exit the setup program. FloCom+ is now ready to be used.
8. Run FloCom+ using the shortcut provided on your desktop. The startup 
menu will appear as shown below.  Click “File>Comms settings...” to 
configure FloCom+ for your computer.

9. Select the serial port of your computer which will 
be used to communicate with the Flo Series3 device 
when a local connection will be made (i.e with a 
serial cable directly connected to the device). 

If using a USB to Serial adapter 
please refer to the product product 
documentation supplied with the adapter 
to ensure the correct driver is installed

If one is present, select the modem which will be 
used if remote communication will take place with 
the device. (The Flo device must also have a modem 
attached to it at the remote site). 
Click “Apply” to save the settings.

http://macemeters.com/
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17.0 	Connecting to the device

1. Unscrew the cover from 
the communications port.
2. Connect a MACE serial 
cable (Part No. 891-300) 
between the serial port of 
the computer and the serial 
port of the FloSeries3 device 
located on the underside of 
the electronics module.

3. Click “Connect>direct”. Enter the password which has been set in the unit 
and select continue. (The default password is “superid”).
4. The “MACE FlocomPlus” dialogue box appears featuring the main menu 
which includes the device status summary screen as shown below.

The device must be configured and started before the meter will  
record flow

Once finished, remove the MACE serial cable and screw the serial port 
cover back in place to maintain enviromental protection

17.1	 Connecting to the device using the serial port 17.2	 What to do if the password is lost/forgotten
In the event that you have forgotten or lost your password, the following 
steps should be taken.1

3. In the “Connect to device” dialogue box the device’s unique authorisation 
code is seen at the bottom.   

You MUST note this code EXACTLY to fulfil the next steps

4. The unique device serial number located on an adhesive label inside the 
box should also be noted.  This will be used to verify the history of the device.
5. Once you have noted the code and serial number, you must contact your 
local MACE dealer/distributor and inform them of these details.  They will 
obtain a “counter-code” for your device.  

You will be required to prove that you have the authority to access 
the device prior to a “counter-code” being issued.  For a billing 
device, only an official of the water distribution authority will be 
given the “counter-code”.  No exemptions from this requirement 
will be given

6. From the “MACE FloCom Plus” main screen, click “Connect>Direct” and the 
“Connect to device” dialogue box will appear.  

This “counter-code” has a time limit on its validity (typically three 
days).  It must be used to access the unit within this time or it will 
be void and a new one will need to be produced

Enter the 16 digit authorisation “counter-code” into the “Password” field and 
click “continue”.  You will now have super user access to the device.

You should immediately change the super password to one that 
will not be forgotten (see Chapter 18.3 for details)

1. From the “MACE FloCom Plus” 
main screen, click “Help>Show device 
authorisation code”.
2. Click “Connect>Direct” and the 
“Connect to device” dialogue box will 
appear. 

Underside of Electronics Module
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18.0 	System information

From the main menu click “System” and the following drop down menu 
options will appear as listed below:

18.1 Set device date/time
The device date and time must be set correctly, 
so that data can be accurately matched to 
known time intervals. 
•	 The date and time can be set by manual entry 

or by synchronizing with the computer time.
•	 The time is held in 24 hour time.
•	 Allowance can be made for daylight  

savings time.

18.2 Change download password
The download password allows low level access 
to the device. When this password is used for 
entry to the device, channel totals may be 
viewed and data can be downloaded. 
Many irrigation districts give this password 
to irrigators to allow them to use the data for 
water management operations. 

18.3 Change super password
The super password allows high level access 
to the device. When this password is used 
for entry to the device, all editing functions 
(including data downloading) are allowed.
Most irrigation districts set this password to 
prevent non authorized access to the device.

Both the super and download 
passwords are case sensitive.

18.4 System settings
The system settings function allows the 
user to change the measurement units from 
metric to U.S and vice versa.

18.5 Clear stored data
This function should only be used by high 
level users. It clears all stored data from the 
device including all time stamped flow rate 
data.

18.6 Module check
This function provides the user with a simple 
method of identifying the FloSeries3 modules 
which are currently installed in the device.
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19.0 	Configuring the device

1. From the main menu click “Settings” and the “AgriFlo settings” dialogue 
box will appear:

Site I.D
The site i.d is a text field used to 
identify the location of the device. 
When data is retrieved from the 
device, it will be identified by this 
name.
For example, the site I.D might 
be the name of the farm or water 
licence number.

Measurement and  
Logging Interval
The measurement interval 
is the time at which the 
device ‘wakes up’ to calculate 
the flow rate readings on 
each of the configured flow 
channels.  Each totaliser 
channel is also updated after 
each measurement interval.
Data is logged in the data file 
ONLY at the logging interval.
The measurement interval 
will always be shorter than 
or equal to the logging 
interval.  
In the case of the 
measurement interval being 
shorter than the logging 
interval, then the data 
logged will be the average of 
those values calculated per 
measurement interval.

Event logging
This function is designed to save 
memory inside the device.
If a value that DOES NOT exceed the 
flow rate threshold (see Chapter 
20.1 - Flow calculation tab sheet) is 
calculated on all of the channels at 
the same time, no data is logged for 
that time stamp. 
If a value that exceeds the flow rate 
threshold has been calculated on at 
least one of the  configured channels 
at the defined logging interval, then 
data is logged for that time stamp.

Log totals 12 hourly
When selected, this function 
records the accumulated total of 
each channel in the data at midday 
and midnight. If unselected the 
accumulated totals are logged ONLY 
at midnight.

Flasher enabled
This function activates the high 
intensity LED on the front face of 
the device. The LED will flash if a 
value that exceeds the flow rate 
threshold has been measured on 
any of the configured channels.

Sensor slot id
If a “Doppler” module is installed in 
the device it’s slot id number will be 
shown. Select the corresponding slot id 
from the drop down for each channel 
that requires configuring.

20.0 	Configure new channel

1. From the AgriFlo settings dialogue box click “New channel” and the  
“Configure new channel”  dialogue box will appear.

Channel name
Type in a name for the channel that will 
be configured. This channel name MUST 
be unique and will be displayed both 
on the AgriFlo’s LCD display and in the 
logged data file.

2. Click “Continue” and the  “Edit channel configuration”  dialogue box will 
appear as shown over page.
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20.1 	Flow calculation tab sheet

Decimal places
This parameter defines the number of decimal places to which the flow rate 
for the particular channel is recorded and displayed.

Flowrate threshold
The flow rate threshold defines the trigger point at which flow rate data for 
the channel is event logged. If the threshold is not reached, the flow rate is 
not logged, but IS used to update the totaliser channels.

Flow units
The flow rate/volume units can be selected by the user at this point and 
define how the data is calculated and logged. (See Chapter 18.4 System 
settings to switch between metric and U.S units). 

Velocity correction
Unfortunately, ideal hydraulic conditions cannot be achieved at every site 
that requires monitoring. In locations where hydraulic conditions are such 
that velocity calibrations at various flow regimes are required, then the 
velocity factors function may help.  Under abnormal hydraulic conditions, 
the average velocity of the stream must be calculated using traditional 
means that comply with Australian (refer to AS3778 series) or International 
Standards.

The velocity correction parameter can be set to scale the calculated 
velocity result and should only be used with extreme care

In full pipe applications, it allows a single multiplication factor to be applied 
to the calculated velocity readings.
In partially full pipes or channels, up to 4 factors can be applied to the 
calculated velocity reading, depending on the depth of the stream.
To edit the velocity click “Change/Edit” on the “Velocity correction” panel as 
shown. A “Velocity Factors” dialogue box will appear as shown to the left.

Siltation depth
This parameter can be used to correct the calculated flow rate if a known 
amount of silt is inside the pipe.
The depth of silt will be subtracted from the area calculation in order to 
calculate the corrected flow rate.

Edit channel configuration dialogue box - Flow calculation tab

Decimal places

Flowrate threshold

Velocity correctionPolynomial coefficients

Flow volume units

Flowrate units

Siltation depth
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Polynomial function
Used if flow in partially full non-circular shaped pipe or open channel.

The polynomial function will ONLY be visible when “other conduit type” 
is selected.  See Chapter 20.2 for details

	 Polynomial co-efficients
	 When the stream flow is in an open channel (non-circular), the user must 

determine the cross-sectional area and relate it to depth via a polynomial 
equation. MACE Flo-series instruments can use 5th order polynomial 
equations. The polynomial co-efficients listed in FloCom+ are related to the 
following equation:

	 Cross-Sectional Area = A + B*X +C*X2 + D*X3 + E*X4 + F*X5
	 Where X = depth of stream
	 The co-efficients are listed in order A, B, C, D, E, F.

	 Import parameters from FloCalc
	 The Mace utility program FloCalc (download separately from  

www.macemeters.com) can be used to draw regular and irregular channel 
shapes. These shapes are then converted into a 5th order polynomial. 
Their co-efficients can be imported directly into the appropriate fields in 
FloCom+ by clicking “Copy to clipboard” and “Exiting” from FloCalc. See 
separate user manual.  

	 Depth limit
	 When the cross-sectional area of a stream is calculated using the 

polynomial co-efficient method, the user must set the depth limit at 
which the polynomial reaches a maximum.  For example, if a channel has a 
maximum depth of 1.5m the depth limit should be set at 1.5m as well

20.1 Flow calculation tab sheet - continued

http://macemeters.com/
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Sensor type

Edit channel configuration dialogue box - Sensor parameters tab

Sensor orientation

Conduit type

Velocity range

Velocity integration period

Velocity calculation method

Velocity maximum 
measurement count

Velocity peak threshold

20.2 	Sensor parameters tab sheet

Sensor Orientation
Under usual field conditions the velocity sensor should be positioned so that 
the transmitted beam is faced upstream. For example, MACE recommends 
that the velocity sensor is positioned so that there are six pipe diameters 
of straight flow before the sensor and two pipe diameters of straight flow 
behind the sensor.  In practice this may not always be possible.  However, 
these conditions may also be met by positioning the sensor to face 
downstream for 6 pipe diameters.  At poor signal sites, turning the sensor 
around may help to increase signal strengths.
The “Sensor Orientation” feature allows the user to tell the processing 
electronics that although the velocities received are negative (when the 
sensor is facing downstream), you wish to totalise this flow as positive flow.

NOTE:  When receiving data from a sensor facing downstream, the real-
time velocity graph will show a spectrum that appears upside down

Velocity range
This parameter sets the range of expected velocities that are to be analysed.  
MACE Flo-series instruments “pigeon-hole” velocity readings into 128 
positions over the velocity range set by the user.  For example, each “hole” in 
a range of 0 - 4 m/s is .03125 m/s wide, whereas in a 0 - 1 m/s range each hole 
is .0078 m/s wide.  For example, in a stream in which the user knows that the 
peak velocity will never exceed say, 0.6 m/s a velocity range of 1 m/s may be 
set.  In this way, the resolution of the final average velocity is increased.  
Furthermore, in slow moving streams or ones that contain few acoustically 
reflective particles, a smaller velocity range will often result in far more 
repeatable data because the instrument does not waste processing power 
gathering data outside of expected ranges.  To be safe, the velocity range 
should be set larger than expected and the site monitored for several weeks 
under different flow conditions to determine the peak expected velocity.  
After this period, the user may find it prudent to increase the resolution by 
changing the velocity range.  

The velocity range must be set so that ALL components of the stream 
velocity are captured when viewed on the “real-time” graph.  Failure 
to do so will compromise the validity of the velocity calculation. See 
Chapter 22 for further details

Sensor type
This parameter defines the type of sensor which is connected to the device.

Conduit type
This parameter defines the type of structure that the sensor is mounted 
within. For example, this can be set to “circular pipe”, “non-circular pipe” or 
“other conduit type”.
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Velocity integration period
The integration time is the period in which samples of the velocity spectrum 
are taken before an average velocity reading is calculated.  The minimum 
integration time is 4 sec and the maximum integration time is 180 seconds 
and may be reduced automatically by the measurement interval and 
the maximum measurement count depending upon the instrument 
configuration.
The integration time may be varied for several reasons:
•	 Under field conditions where the flow is fluctuating dramatically, increasing 

the integration time will help to get a more accurate average velocity 
reading, because more samples are available to calculate the average .

•	 Under field conditions where the flow has a low number of acoustically 
reflective particles, increasing the integration time will help to get a more 
accurate average velocity reading, because more reflective targets will be 
sampled to calculate the average.

The power consumption of the system is affected by the integration 
time.  The longer the unit is on and physically sampling, the shorter the 
battery life without charging. The Flo Series3 internal battery has a  
7.2 Ah capacity. During an integration period each Doppler sensor will 
draw approximately 120 mA. 

Velocity maximum measurement count
Under certain flow or no flow conditions signal noise may disrupt the 
calculation of a true average velocity reading.  As described the peak 
threshold feature is designed to overcome this problem.  However, unwanted 
velocity readings may be derived from other sources such as aquatic life, 
which may give strong signal strengths.
Within all Flo-series instruments one of two flow states can occur. The 
stream can either be moving or stationary.  For example, a Flo-series sensor 
submerged in a river diversion pipe that is used to pump irrigation water may 
be full at times when no water is being pumped.  Under these conditions, 
it is common for fish and aquatic invertebrates to inhabit the pipeline.  
Unfortunately, to a Doppler ultrasonic velocity sensor, a fish swimming at  
500 mm/s is computed as a full pipe of water moving at 500 mm/s.  This 
type of erroneous flow reading will result in an increase in the totalised 
flow.  Conversely, in a slow moving stream or one that contains few 
acoustically reflective particles, a velocity reading may be missed if there is 
insufficient data to analyse.  Under this circumstance, the totaliser will not be 
incremented.  

20.2 	Sensor parameters tab sheet  - continued
To overcome this problem, MACE Flo-series instruments include the 
maximum measurement count feature whereby if the instrument detects a 
state change (i.e flow has started or flow has stopped) it stays on and takes 
X number of readings to confirm this situation.  If all X number of readings 
meet the criteria for a valid reading as set by, peak threshold, flow threshold, 
minimum stream activity and stream activity percentage, then the reading is 
accepted and the change of state confirmed.  If the readings do not all agree 
that there has been a change of state, then the reading is “discarded” and the 
current flow state remains.  That is, the unit continues to calculate zero flow 
or accepts the flow rate as calculated.
Furthermore, the Flo-series instrument also checks that the direction of flow 
has not changed within the X readings.  For example, if there is zero flow and 
the unit detects a reading of positive flow and another of negative flow then 
the overall reading is discarded and the unit continues to register a zero flow.
The number of readings used for the maximum measurement count is 
configurable by the user. 

Velocity calculation method

Pump method - Under normal conditions, water flow that is provided by 
a pump is turbulent and contains a vast number of acoustically reflective 
particles, particularly miniature air bubbles that are a result of cavitation 
events.  In monitoring sites that are pumped, or where low signal strengths 
are uncommon, the pump method should be used.

Surface wave rejection - In severely turbulent, open conduit flows such 
as encountered in a sewerage system, it is common for standing waves to 
develop in the flow stream.  If situated closely, these standing waves (surface 
waves) may confound a Doppler ultrasonic sensor because they typically 
result in reflections of a significantly slower velocity.  In the diagram, a 
surface wave can be seen as a sharp peak on the real-time graph at about the 
0.2 m/s mark.  
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In this case, if the user selects the surface wave rejection calculation method 
a menu item called “low-end cutoff” will be displayed.  This feature enables 
the user to force the Flo-series instrument to ignore Doppler shifts that lie 
between zero and the low-end cutoff.  The low-end cutoff is a percentage of 
the range (x-axis) of the real-time graph.  In the diagram  the low-end cutoff 
would be configured to about 10% of the graph.  That is, any data that are 
received between 0 and 0.4m/s will be ignored when computing an average 
stream velocity (greyed area, not represented in actual real-time graph).

Gravity method - This method should be used wherever a stream is slow 
moving and/or contains few acoustically reflective particles.  Because this 
calculation method is designed to enhance the velocity processing of slow 
moving/clean streams, it may also result in erroneous velocity readings 
unless enabled correctly.  When enabled, this method will display two new 
menu items.  

	 Minimum stream activity
	 Under conditions of zero flow within a conduit (see maximum 

measurement count) a single aquatic life form can produce large Doppler 
shifts.  The minimum stream activity parameter must be set to negate the 
effects of these aquatic life forms.  This parameter should be set to low 
values (2-10) in sites where extremely slow average velocities are expected 
(< 0.2 m/s).  Values greater than 10 can be set where average velocities of 
>0.2 m/s are expected. 

The user MUST check that the value does not cause real velocity data to 
be ignored

	 Stream activity percentage
	 To be used in conjunction with the minimum stream activity parameter, 

this parameter forces the Flo-series instrument to utilise only those velocity 
spectrums that have a minimum stream activity value greater than set 
by the user.  Under good acoustic conditions typically 90 –100% of the 
data received by the velocity sensor will be used to calculate an average 
velocity.  Under conditions where the data received by the velocity sensor 
has been caused by aquatic life, typically <10% of the data will be used.  
Therefore, this parameter should be set to low values (2-10) in sites where 
extremely slow average velocities are expected (< 0.2 m/s).  Values greater 
than 10 can be set where average velocities of >0.2 m/s are expected.  

The user MUST check that the value does not cause real velocity data to 
be ignored

Velocity peak threshold
Doppler shifts that are unrelated to the measurement of velocities in a 
stream are often called “signal noise”.  This “noise” can be a result of several 
different factors including:
•	 electromagnetic interference
•	 reflections of signals from other echoes
In some situations background noise may interfere with the calculation of 
correct average velocity readings.  Flo-series instruments feature a “noise 
filter” called a “peak threshold”. 

In the figure above signal noise can be seen on the velocity spectrum graph 
as low signal strength echoes.  In the graph above you can see that the signal 
noise has an approximate amplitude value of 75.  Therefore, by setting a 
threshold of say 100, this noise will be ignored in the computation of average 
velocity.  The user should be careful however, at sites where signal strength 
is inherently lower, a peak threshold that is set too high could mean that true 
velocity readings are discarded.
This feature is particularly useful at sites where the sensor may be 
submerged for periods where no flow is occurring. For example, signal 
noise encountered in a submerged 1 m diameter pipeline that gives a false 
“average velocity” of 1 m/s will still increase a totalising counter by 785 litres 
per second, even though no true flow existed.  By watching several real-
time graphs of no flow conditions and monitoring the extent of signal noise 
apparent, a peak threshold may be set so that signal noise is not computed 
as real flow.

20.2 	Sensor parameters tab sheet  - continued
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Depth parameters

Depth slope and offset
If the user has a sensor with known slope and offset characteristics, they 
may be entered directly into the unit configuration.  For example, the 
MACE Ceramic Pressure Transducer is supplied with a factory calibration 
tag indicating the sensor’s slope and offset values.  Alternatively, the user 
should perform a 2-point calibration to determine the slope and offset 
characteristics of the sensor.

The factory calibration tag includes slope/offset values for both metres 
(m) and inches (in).  Be sure to enter the correct values for the selected 
depth units

2-point calibration 
To correctly calibrate a depth sensor it is important to calibrate it over its 
useful range.  For example, if a sensor has a range of 0 - 2 metres but you 
only wish to use it to measure the range 0.1 metres to 1.2 metres, you should 
recalibrate it across the reduced range.  
The two point calibration function is selected by clicking “2 point 
calibration”. The “Depth: 2 point calibration” dialogue box appears:

The measured raw value from the depth sensor 
is displayed at the top of the window and is 
updated approximately once per second.
To carry out a two point calibration, prepare 
the measurement set up for the first calibration 
point and when the current raw value has 
stabilised, click on “Set” in the “1st point” 
box. The current raw value is copied to the 
“Raw value” field and the “Depth” field is 
enabled. Enter the actual depth value in the 
“Depth” field. Now prepare the measurement 
set up for the second calibration point and 
repeat the procedure in the “2nd point” box. 
Click on “Apply” to calculate the new slope 
and offset parameter values for the associated 
depth channel. Clicking on “Cancel” terminates 
the procedure without altering the parameter 
values.

Offset adjust 
This function is used to “fine tune” the depth reading whenever the sensor 
is deployed or reading inaccurately.  For example, the depth sensor may 
be sitting slightly off the bottom of the stream, or the user has deployed it 
above a silt line on the side of a pipe.
The offset adjustment function is selected by clicking on “Offset adjust”. The 
“Depth: Offset adjust” dialogue box appears:
The depth value is displayed at the top of the 
window and updated approximately once 
per second. To adjust the depth offset value, 
enter the actual depth value in the “Corrected 
value” field and click on “Apply”. Clicking on 
“Cancel” terminates the procedure without 
altering the offset value.

20.2 	Sensor parameters tab sheet  - continued

Depth measurements should always be carried out from the 
bottom of the channel/pipe to the top of the water level
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21.0 	Configuring FloSI Card

The Flo Series Serial Interface (FloSI) is an optional upgrade module for Flo 
Series3 devices. The FloSI provides unconditional polling access to the most 
recent user configured measurement results of Flo Series3 devices.

NOTE:  Only one FloSI per Series3 device is supported

RS-232, RS-485 and SDI-12, interfaces are available from Flo Series3 
devices with the use of a FloSI. The FloSI enables users to request the 
last measurement from Flo Series3 devices without the complexity of 
communicating via the host communications port.
The FloSI cannot be used to download or configure a Flo Series3 device, and 
only one serial protocol may be used at one time.
The FloSI requires no routine maintenance and has no user serviceable 
components.
Configuration of the FloSI requires MACE Flocom+ (Version 1.0.1.5 or later) 
software and successful PC communications with a MACE Flo Series3 device 
(Firmware Version 1.01.0 or later). The FloSI configuration settings are 
available from the “Settings” menu of Flocom+.

21.1 	Configuring a FloSI
Establish communications with the device as per Chapter 17 - Connecting to 
the device.
Ensure at least one Doppler card is configured as per Chapter 20 - 
Configuring new channel.  Then check the “FloSI enabled” box.

Click “FloSI“ and then click 
”Change” to select the output 
mode that you wish to use.

21.2 	Serial Interface Settings
The FloSI can only be configured to use one serial protocol from the three 
available. The parameter values are provided in the user configured units. 

21.2.1 RS-232, ASCII Mode
The line transmission characteristics are as follows:
	 Baud rate:	 9600
	 Data bits:	 8
	 Parity:		  None
	 Stop bits:	 1
In this mode, the FloSI is dormant while RTS is inactive. On RTS going 
active, the FloSI transmits the most current result string from the Flo Series3 
device. If RTS is active when a scheduled sample is made, then the string is 
transmitted immediately on completion of the measurement.
The transmitted ASCII text string starts with the character ‘ * ‘(asterix), ends 
with a carriage return and contains the configured number of channel 
values. The number and order of channel values in the output string can be 
configured using Flocom+. Each channel value in the string always begins 
with either a ‘+’ (plus sign) or ‘-‘ (minus sign) - there are no spaces between 
values.

21.2.2 MODBUS Mode
The MODBUS implementation complies with the “MODBUS over Serial Line 
Specification V1.0” and the “MODBUS Application Protocol Specification V1.1”.
The external port is either a standard RS232 port or a two-wire RS485 port, 
depending on the selected MODBUS mode. The MODBUS parameters are 
configurable by selecting the entering the appropriate Address, selecting the 
correct baud rate from the drop down list and checking the required radar 
buttons

NOTE: The user must 
ensure that there are 
no two devices with the 
same address on the 
same bus. In such a case, 
the behaviour of the bus 
is unpredictable
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21.2 	Serial Interface Settings - continued

Notes:

1. Register byte order is big-endian
2. Float values are formatted according to IEEE 744 32-bit representation
3. Flow total has a range from 0 to 999999.9
4. Registers corresponding to parameters, which are not configured to be measured or calculated, 
contain random values.
5. AgriFlo channel outputs are in order of channel configuration as per AgriFlo settings

Supported function codes:

Command	 Code (hex)	 Sub-code (dec)

Read Input Registers	 04	

Diagnostics	 08	 00-04,10-18

Register map:

Parameter	 AgriFlo Output5	 Type	 Size (bits)	 # Registers	 Register(s)

Channel 1	 flow rate	 float	 32	 2	 40001-40002

Channel 2	 total	 float	 32	 2	 40003-40004

Channel 3	 flow rate	 float	 32	 2	 40005-40006

Channel 4	 total	 float	 32	 2	 40007-40008

Channel 5	 flow rate	 float	 32	 2	 40009-40010

Channel 6	 total	 float	 32	 2	 40011-40012

Channel 7	 -	 float	 32	 2	 40013-40014

Channel 8	 -	 float	 32	 2	 40015-40016

Channel  9	 -	 float	 32	 2	 40017-40018

Channel 10	 -	 float	 32	 2	 40019-40020

Channel 11	 -	 float	 32	 2	 40021-40022

Channel 12	 -	 float	 32	 2	 40023-40024

Channel 13	 -	 float	 32	 2	 40025-40026

Channel 14	 -	 float	 32	 2	 40027-40028

Channel 15	 -	 float	 32	 2	 40029-40030

Channel 16	 -	 float	 32	 2	 40031-40032

Channel 17	 -	 float	 32	 2	 40033-40034

Channel 18	 -	 float	 32	 2	 40035-40036

Channel 19	 -	 float	 32	 2	 40037-40038

Channel 20	 -	 float	 32	 2	 40039-40040

21.2.3 SDI-12 Mode 
The SDI-12 implementation complies with V1.3 of the SDI-12 specification.
Configurable parameters are:
•	 Address (‘0’-‘9’, ‘A’-‘Z’, ‘a’-‘z’)
•	 Which measurement results to provide
On receiving an SDI-12 Measurement command, the FloSI replies with 
notification that the measurement results are immediately available.  Upon 
receiving a Send Data command, the FloSI returns the currently available 
result data which it has been configured to provide.

The following SDI-12 commands are supported:

Name	 Command	 Response

Acknowledge active	 a!	 a<CR><LF>

Send Identification	 aI!	 a13MACE P/FloSI3100#nnnnn<CR><LF>

Address Query	 ?!	 a<CR><LF>

Start Measurement	 aM!	 a000n<CR><LF>

Start Measurement and 	 aMC!	 a000n<CR><LF> 
Request CRC	

			   a<values><CR><LF> 
Send data	 aD0!  to  aD9!	 or 
			   a<values><CRC><CR><LF>

Additional Measurements	 aM1!  to  aM9!	 a0000<CR><LF>

Additional Measurements 	 aMC1!  to  aMC9!	 a0000<CR><LF> 
and Request CRC

Start Verification	 aV!	 a0000<CR><LF>

Start Concurrent Measurement	 aC!	 a000n<CR><LF>

Start Concurrent Measurement 	 aCC!	 a000n<CR><LF> 
and Request CRC	

Additional Concurrent 	 aCC1!  to  aCC9!	 a0000<CR><LF> 
Measurements

Continuous Measurement #0	 aR0!	 a<values><CR><LF>

Continuous Measurements #1 to 9	 aR1!  to  aR9!	 a<CR><LF>

Continuous Measurement #0 	 aRC0!	 a<values>< CRC><CR><LF> 
and Request CRC	

Continuous Measurements #1 to 9	 aRC1!  to  aRC9!	 a< CRC><CR><LF> 
 and Request CRC
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21.0 Configuring FloSI Card - continued

The number and order of channel values in the output string for SDI-12 or 
RS232, ASCII output can be configured using Flocom+.

Move the required channels from the “Available channels” table to the 
“Output channels” table by highlighting the desired channel in the 
“Available channels” table and clicking the “Right arrow”. If a channel in the 
“Output channels” table is no longer required, highlighting it and clicking 
the “Left arrow” will remove from the “Output channels” table. The position 
of a channel in the “Output channels” table can be changed by highlighting 
the channel and clicking the “Up arrow” or the “Down arrow”.

The user must ensure that there are no two devices with the same 
address on the same bus. In such a case, the behaviour of the bus is 
unpredictable

22.0 	About real time data

MACE Flo-Series instruments measure average stream velocity using Doppler 
ultrasonic technology.  Anything moving in the stream, which is acoustically 
reflective, may produce an echo and therefore a Doppler shift.  Acoustically 
reflective particles include:
•	 suspended solids
•	 bubbles, eddies and waves
•	 larger particles such as, sand, leaves and pebbles.
When selected in FloCom+, the user can display a real-time graph of the 
velocity spectrum received by the velocity sensor.  The histogram you see in 
real-time data is a composite spectrum of the velocities of the stream flow as 
well as various other factors explained below.
•	 The graph is two dimensional (X-Y).
•	 The X-axis is the velocity (range set by user).
•	 The Y-axis (vertical) is the strength of the signal received by the processing 

electronics from each velocity sensed in the spectrum.
•	 Several thousand data points are plotted to give the composite graph.  
MACE Flo-Series instruments measure several thousand data points and 
compute an average velocity. The flow is then calculated using the formula:

  Q=V x A
  where: Q= Quantity, V= Stream velocity and A= Cross-sectional area.
Users of MACE Flo-Series instruments can use the real time graph to 
determine the correct positioning of the velocity sensor by assessing the 
shape of the curve and the signal strength.  The following graph is an 
example of a spectrum that was received from a full pipe irrigation flow.  
Under field conditions, several factors can affect the spectrum without 
affecting the performance or accuracy of the velocity sensor.
Armed with an understanding of these factors and some field experience, 
the operator can vary the position of the sensor and the system settings to 
correct site induced errors in the velocity readings.
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Factors affecting the velocity sensor
This section is designed to give the operator a brief understanding of some of 
the factors affecting the performance of the MACE Flo-Series velocity sensor.
In flowing streams, there are always a range of different velocities present, 
particularly in turbulent water where the effects of eddies and boundary 
layers can cause the velocity histogram to appear distorted in the diagram 
below. Although distorted, MACE Flo-Series instruments have powerful 
signal processing algorithms, which determine the average stream velocity 
from these signals.

If the operator is receiving data such as displayed in the diagram above, 
the sensor may be moved slightly to try to overcome the distortion.  
Furthermore, the operator should inspect the positioning of the sensor to 
ensure that there is not a build-up of debris or other matter, close to the 
sensor head.  If no obstruction is observed and re-positioning the sensor 
does not improve the data, you can be assured that the sensor is operating 
effectively and that the displayed data is a site induced phenomenon.

If data such as that seen above is received, the operator should ensure that 
the sensor is positioned correctly and monitor the site for any obstructions 
close to the sensor. If no obstructions are located close to the sensor, the 
site may be unsuitable to flow measurement with Doppler ultrasonic flow 
devices. 
The signal strength of received echoes on the real-time histograms, is 
a measure of the number of reflective particles moving in the stream.  
Therefore, low signal strengths do not necessarily equate to poor velocity 
readings. Relatively few particles may provide enough echoes for an accurate 
average velocity reading. Furthermore, a histogram with a broad base will 
generally tend to have a peak with a lower signal strength.  In sites where it 
is suspected that there are relatively few reflective particles in the flow, the 
period in which the MACE Flo-Series instrument takes readings may require 
extending (see, Velocity integration period).

22.0 About real time data - continued
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23.0 	Real time data

Doppler sensor check 
Click “Doppler sensor check” and the “MACE Doppler real-time data” 
dialogue box will open.

Select the channel that you wish to 
observe. Click “Display” and the “Real 
time display” will open.
Click “Start” to begin measurements.
Click “Stop” then “Exit”  to return to the 
main menu. 

From the main menu click “Real time data” and the following drop down 
menu options will appear as listed below:

Measure and display
Click “Measure and display” then “Start” to observe the current flow rate 
values. 

22.0 About real time data - continued

A general rule of thumb, if a spectrum has low signal strength but gives a 
consistent velocity reading, then the measurements should be accurate.  
However, if the spectrum has low signal strength and gives inconsistent 
velocity readings or none at all, the site may be unsuitable for flow 
measurement with Doppler ultrasonic flow devices.
Very distorted signals such as that described in the diagram on the previous 
page may result from interference to the velocity sensor by the build-up of 
debris or siltation.
In sites where there is an expectation of sedimentation, the velocity sensor 
should be mounted in a raised position. In a full-pipe application, it is 
recommended that the sensor be mounted (or inserted) on the side of the 
pipe to avoid sedimentation.
Similarly, in partially full pipes, the sensor may be offset from the invert of the 
pipe.  In these instances, the depth reading will need to be offset accordingly.
Covering the sensors with algae and other materials that are saturated 
generally does not affect the accuracy of velocity readings.  This is because 
saturated materials exhibit the same speed of sound as water.
MACE Flo-Series instruments include several signal processing features 
specifically designed to overcome anomalous data produced by such 
phenomena as: aquatic life (fish, weeds, small invertebrates); surface waves 
(produced by turbulence and wind); and background noise.  
It should always be remembered when examining real-time graphical data, 
that settings within the unit itself can have a marked effect on the data 
displayed.  The configuration of the instrument should always be checked 
thoroughly before viewing real-time data.
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24.0	Start/Stop device

From the main menu click “Start device” and you will 
be asked “Are you sure?”. Click “Yes” and the device 
will start and you will be returned to the main menu. 
You will notice that the “Start Device” has changed to 
“Stop device” in the main menu.

Once the FloSeries3 device has been configured and tested it is ready to be 
started so that measuring and logging is initiated.

WARNING - If the device is NOT started flow measurements will  
not occur

To enable changing of settings, access of real-time data and resetting totals, 
the AgriFlo must first be stopped.

25.0 	Disconnect

From the main menu click “Disconnect” and 
you will be asked “Are you sure?”. Click “Yes” and 
the device will be disconnected and you will be 
returned the start up menu. Click on “File>Exit” 
to shut down FloCom+.

WARNING - If FloCom+ is not disconnected from the device excesscurrent 
will be drawn from the main battery

From the main menu click “Stop device” and you 
will be asked “Are you sure?”. Click “Yes” and the 
device will stop and you will be returned to the 
main menu.  You will notice that the “Stop Device” 
has changed to “Start device” in the main menu.

26.0 	View totals

From the main menu click “View totals” and the “Flow volume totals” 
dialogue box will appear.

If the AgriFlo has not been started, the “Set/Reset” button will be active and 
the totalised reading can be changed.

It is strongly advised to download the logged data PRIOR to 
resetting the total value

3. Enter the “New value” into the 
field and click “Set value”.  The new 
value will then be displayed in the 
“Flow volume totals” dialogue box.

Double check that this value is CORRECT

4. If the AgriFlo has not been stopped, the “Set/Reset” button will be greyed 
out and the total/s will not be re-settable.
5. To update the reading whilst flow is accumulating, click “Refresh”.

1. Highlight the channel you wish 
to reset by clicking on it’s name.
2. Click “Set/Reset” and the “Set 
total value” dialogue box will 
appear.

This dialogue box lists all the 
accumulated flow channels and 
their respective totals and units.
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27.0 	Downloading stored data

From the Start up screen click “Connect >Direct” to display the main menu.
Select “Download” to initiate the stored data download procedure. 
A save file dialogue box will appear.  The default file name is the unit ID.  The 
default target directory is the directory into which the previous download file 
was stored.
Click “OK” once you are ready to download the device.  The “download” 
dialogue box will appear which shows the amount of stored data in the 
device and the date of the earliest available record. If the download end time 
is left unchanged or set to a time earlier than the earliest record, all stored 
records will be downloaded. Otherwise, only those data stored after the 
chosen “Download from” date will be downloaded.
Click “Start download” to complete the download procedure.

28.0 	View downloaded data file

This function is accessed via the “File” function on the Start up menu and 
then selecting the “View download file” option.  

Opening a file
On entry, an open file prompt window is displayed. If downloaded data was 
saved during the current session, the last downloaded data file appears as 
the default selection. On selecting “Open” the selected file is loaded and if 
successful the data is displayed as a text file. A different downloaded data 
file may be selected at any time by selecting the local “File” function and 
repeating the file selection procedure. 

Viewing a file

Time stamp tree view
This pane enables the user to quickly navigate the data file by date and 
time. Expand the tree on the date of interest by clicking the “+” to reveal the 
various time stamps. Click the time stamp you wish to view and the data file 
will automatically scroll to it.

Header 
information

Time stamp tree view

Status  
messages

Time stamped  
data

End of file
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28.0	 View downloaded data file - continued

Header information
At the top of each data file the following information is displayed:
•	 Version of FloCom+ used to download the file;
•	 Time and date the data were downloaded to the PC;
•	 Device type; ie AgriFlo, FloPro or HydroMace 3000;
•	 Serial number of the electronics module;
•	 Version of firmware installed in the electronics module;
•	 Time and date of the clock in the electronics module;
•	 Battery status and charge (voltage) of the electronics module;
•	 The units of measure used for the accumulated total of each channel;
•	 The current total for each channel at the time of data download;
•	 Number of channels being recorded;
•	 The names of each channel being recorded;
•	 The units of measure used for each channel being recorded;
•	 ‘Points’ refers to the number of data lines in the dowloaded file;
•	 ‘Interval’ refers to the time in seconds between each time stamp (logging 

interval).

Status messages
Status messages are defined by the use of an asterisk (*) immediately 
following a time stamp. For example, in the download on the previous page 
the following message appears which tells the user the date and time the 
unit was started. 

NOTE: Refer to the table over page for a full listing of status messages

Time stamped data
At each time stamp the date, time and recorded channel values are shown. 
In the example below the date and time are followed by the flow rate value 
recorded for each of the three configured channels.

End of file
The end of the data file is always delineated by a ‘Download End’ followed by 
the date and time.

Status message table

Status message	 Description

Unit started	 AgriFlo was started

Unit stopped	 AgriFlo was stopped

Flow start	 Time at which the “flow threshold” was exceeded for a 
configured channel and the accumulated total at the 
start of the flow event

Flow stop	 Time at which the measured flowrate did not exceed 
the “flow threshold” for a configured channel and the 
accumulated total at the end of the flow event

Flow total	 Accumulated total for a configured channel. Recorded at 
midday and/or midnight (user configurable). 

No external power	 No external power is detected. If a solar panel is used this 
will occur at sunset.

External power restored	 External power is detected. If a solar panel is used this 
will occur at sunrise.

Low Battery	 Time at which battery voltage fell below 11.5V

Battery normal	 Time at which battery voltage exceeded 11.5V

Flat battery condition	 Battery voltage at download time is less than 10V

Battery was flat	 Battery was less than 10V

Sensor not detected	 MACE Doppler sensor not detected

Sensor error	 MACE Doppler module not detected

Device reset #0	 Power up reset occurred

TOD clock error	 Error reading Time-of-day clock	
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